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Q.1   Which university won the first place in the 3rd Khelo India University Games?

A. University of Mumbai
B. Panjab University
C. Shivaji University
D. University of Madras

Answer: B

Sol:
The correct answer is (b) Panjab University.
· The University of Panjab won the first place in the 3rd Khelo India University Games.
· The third edition of the Khelo India University Games took place from February 10 to February 26, 2021.
· The third edition of the Khelo India University Games was hosted by the University of Karnataka in Bengaluru.
· The next edition of the Khelo India University Games is scheduled to be held in the state of Haryana.
· The Khelo India University Games (KIUG) is a multi-sport event organized by the Government of India to promote sports among university-level
athletes in the country.

Q.2   In August 2025, which two countries conducted their first bilateral ‘Maritime Cooperative Activity (MCA)’ exercises in the South China Sea?

A. India and the Philippines
B. India and Vietnam
C. India and China
D. India and Japan

Answer: A

Sol: The correct answer is: (a) India and the Philippines
Explanation:
In August 2025, the navies of India and the Philippines conducted their first bilateral ‘Maritime Cooperative Activity (MCA)’ exercises in the South
China Sea, also referred to as the West Philippine Sea (WPS) by the Philippines. The aim was to enhance maritime interoperability and operational
coordination between the two countries' navies.

Information Booster:
• The exercise aimed at improving operational coordination between the Indian and Philippine navies.
• Indian naval ships that participated included INS Mysore (guided missile destroyer), INS Shakti (tanker), and INS Kiltan (corvette).
• The Philippines deployed two frigates: BRP Miguel Malavar and BRP Jose Rizal.
• The Philippines has been conducting similar exercises since 2023 with countries like the USA, Japan, and France, to counter China's territorial claims
in the South China Sea.
• The exercises were conducted in the South China Sea or West Philippine Sea (WPS), part of the Philippines' Exclusive Economic Zone (EEZ).

Q.3   Where did the Indian Air Force (IAF) land its Rafale fighter aircraft for the Red Flag 24-2 exercise?

A. Nellis Air Force Base, Nevada
B. Eielson Air Force Base, Alaska
C. Edwards Air Force Base, California
D. Wright-Patterson Air Force Base, Ohio

Answer: B
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Sol: The correct answer is (b) Eielson Air Force Base, Alaska.
The Indian Air Force (IAF) landed its Rafale fighter aircraft at Eielson Air Force Base in Alaska to participate in the Red Flag 24-2 exercise. This
multinational exercise is designed to enhance joint, combined interoperability and provide realistic combat training. The participation of IAF Rafale
jets in such exercises aims to bolster aerial combat capabilities and foster cooperation with allied forces.
About Indian Air Force (IAF):
· Chief of Air staff (CAS) – Vivek Ram Chaudhari
· Headquarters – New Delhi, Delhi
· Founded – 1932

Q.4   Which is the first nuclear reactor made in India?

A. Apsara
B. CIRUS
C. Dhruva
D. KAMINI

Answer: A

Sol: The correct answer is (a) Apsara.
· Apsara: India's first nuclear reactor, Apsara, was commissioned on August 4, 1956. It was a pool-type reactor that used highly enriched uranium as
fuel and light water as a coolant, moderator, and reflector. It was designed for research purposes and served as a critical step in India's nuclear
research and development.
Information Booster:
· CIRUS: This reactor was commissioned in 1960 and was also used for research and the production of plutonium.
· Dhruva: Commissioned in 1985, Dhruva is a heavy water reactor used primarily for research and isotope production.
· KAMINI: This reactor, commissioned in 1996, is the world's only reactor that uses uranium-233 fuel, produced from thorium. It is used for research
in neutron radiography and other applications.

Q.5
 

Manu Bhaker and Sarabjot Singh, the first Indian shooting pair to win an Olympic medal in shooting at Paris 2024, defeated players of which
country to win the bronze medal?

A. Malaysia

B. Japan

C. Singapore

D. South Korea

Answer: D

Sol: The correct answer is option (D) South Korea
Manu Bhaker and Sarabjot Singh secured the bronze medal in the 10m air pistol mixed team shooting event at the Paris 2024 Olympics by
defeating the South Korean pair, Oh Ye-jin and Lee Won-ho, with a score of 16-10.

Information Booster :-

The Paris 2024 Summer Olympics were held from July 26 to August 11, 2024, marking the third time Paris has hosted the Games, following
1900 and 1924. This edition featured 32 sports.
Participating Nations: 206 National Olympic Committees.
Athletes: Approximately 11,000
Mascot: The Olympic Phryge, inspired by the Phrygian cap, symbolizing freedom and the French Republic.

Q.6   Which of the following correctly states the aim of Project UNNATI under the Ministry of Rural Development?

A. To skill 100% of all rural households under MGNREGA
B. To provide urban job placements for all MGNREGA workers
C. To train 20% of active MGNREGA workers households for livelihood promotion
D. To replace MGNREGA with self-employment schemes only
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Answer: C

Sol: The correct answer is (C) To train 20% of active MGNREGA workers households for livelihood promotion

Explanation:

Project UNNATI (Upgrading the Skills and Training in Traditional Arts/Crafts for Livelihood Promotion) is a convergence project initiated by
the Ministry of Rural Development.
The primary objective is to skill 20% of all active MGNREGA workers' households, with at least one adult member from the household
receiving training.
The goal is to provide skills that will help these workers transition from being solely wage labourers under MGNREGA to becoming self-
employed or securing better-paying employment opportunities, thereby promoting livelihood diversification and enhancement.
This project aims to break the cycle of dependence on wage employment schemes by providing opportunities for sustainable income
generation.

Information Booster:

The training provided under Project UNNATI is conducted by the Rural Self Employment Training Institutes (RSETIs) established under
the Ministry of Rural Development.
The project provides a total of 130 days of training (30 days of classroom training and 100 days of practical training in the field).
During the training period, a stipend is provided to the trainee, and the cost is entirely borne by the central government.

Additional Knowledge:
To skill 100% of all rural households under MGNREGA (Option A)

This statement is incorrect. The target is specifically for 20% of active MGNREGA households, not all households, due to resource constraints
and the focus on the most in-need households.

To provide urban job placements for all MGNREGA workers (Option B)

This statement is incorrect. The focus is on providing self-employment or improved rural employment opportunities, not exclusively urban job
placements. The training is conducted in rural self-employment training institutes.

To replace MGNREGA with self-employment schemes only (Option D)

This statement is incorrect. Project UNNATI is a complementary program to MGNREGA, aiming to improve livelihoods, not to replace the
fundamental wage employment guarantee provided by MGNREGA.

Q.7   The Khilafat movement was led by ______.

A. Maulana Abul Kalam Azad
B. Muhammad Ali and Shaukat Ali
C. Muhammad Ali Jinnah
D. Syed Ahmad Khan

Answer: B

Sol: The correct answer is (B) Muhammad Ali and Shaukat Ali

Explanation:

The Khilafat Movement (1919–1924) in India was led primarily by the Ali Brothers — Muhammad Ali and Shaukat Ali.
The movement aimed to protect the Ottoman Caliphate after World War I, as the Caliph was considered the spiritual leader of Sunni
Muslims.
It soon merged with Gandhi’s Non-Cooperation Movement, creating a united front of Hindus and Muslims against British rule.

Why Ali Brothers?

They mobilised Indian Muslims and addressed mass gatherings.
Played a central role in forming the All India Khilafat Committee.
Worked closely with Gandhiji for joint Hindu–Muslim political action.

Information Booster:

Maulana Abul Kalam Azad also supported the movement but did not lead it.
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Syed Ahmad Khan opposed mass political movements and was not involved.
Muhammad Ali Jinnah did not support the Khilafat Movement; he believed it mixed religion with politics.
The movement declined after the abolition of the Caliphate by Mustafa Kemal Atatürk in 1924.

Q.8   Which organization is primarily responsible for promoting free trade among nations?

A. World Bank
B. International Monetary Fund (IMF)
C. United Nations (UN)
D. World Trade Organization (WTO)

Answer: D

Sol: The correct answer is: (d) World Trade Organization (WTO)
Explanation:
The World Trade Organization (WTO) is the primary international body responsible for promoting free and fair trade among nations.
It provides a framework for negotiating trade agreements, settles trade disputes, and ensures that trade flows smoothly, predictably, and
without discrimination.
Information Booster:

Established: 1995, replacing the General Agreement on Tariffs and Trade (GATT).

Headquarters: Geneva, Switzerland.

The WTO has 164 member countries (as of 2024) and plays a key role in setting global trade rules and resolving trade disputes.

Additional Information:
World Bank – Established in 1944, it provides long-term financial and technical assistance to developing countries for development
programs.
International Monetary Fund (IMF) – Founded in 1944 at the Bretton Woods Conference, it supports global monetary cooperation and
financial stability.
United Nations (UN) – Formed on 24 October 1945, it works to maintain international peace, security, and development among nations.

Q.9   Which of the following is the earliest to be constituted?

A. Press Council of India
B. United News of India
C. NAM News Network
D. Press Trust of India

Answer: D

Sol: The correct answer is (d) Press Trust of India
Explanation:
• Press Trust of India (PTI) was incorporated in August 1947, immediately after Independence, and began its news services by February 1949.
• It is India’s largest and oldest news agency, formed as a non-profit cooperative among newspapers.
• The other organizations were constituted much later, making PTI the earliest.
Information Booster:
• PTI serves most major newspapers, television channels, and digital platforms across India.
• It replaced the British-owned Reuters service in India after independence.
Additional Knowledge:
Press Council of India (Option a)
• Established on 4 July 1966.
• It functions as a statutory, quasi-judicial body to preserve freedom of the press and maintain journalistic standards.
United News of India – UNI (Option b)
• Founded on 19 December 1959.
• It is the second major news agency in India after PTI.
NAM News Network – NNN (Option c)
• Formed in November 2005 by the Non-Aligned Movement (NAM).
• It is a collaborative news platform of NAM member nations.

Q.10
 

What is the name of the female humanoid robot developed by ISRO that was sent on an uncrewed test flight in 2024 as a precursor to the
Gaganyaan manned space mission?
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A. Gagan-Sakhi
B. Nabha-Nari
C. Vyommitra
D. Mitra

Answer: C

Sol: The correct answer is (C) Vyommitra

Explanation:

Vyommitra is the name of the female half-humanoid robot developed by the Indian Space Research Organisation (ISRO).
The name is derived from two Sanskrit words: "Vyom" (meaning Space) and "Mitra" (meaning Friend), which translates to "Space Friend".
Vyommitra's purpose is to be a precursor to the first crewed Gaganyaan mission by performing experimental functions in the uncrewed test
flights.
She is designed to simulate human functions in the space environment, monitor the in-flight conditions, interact with the life support systems,
and report back to the ground stations.
The first TV-D1 uncrewed test flight took place on October 21, 2024, successfully testing the crew escape system, and Vyommitra is scheduled
to fly on a subsequent test flight to further validate the safety and reliability of the spacecraft systems.

Information Booster:

Vyommitra is a "half-humanoid" because she has a head, hands, and a torso, but no legs.
She can speak in both Hindi and English and can perform various operations of the space capsule.
The mission involving Vyommitra is crucial for ISRO to understand how the body might react in space and to ensure all systems are perfect
before sending human astronauts (called Gaganauts) into space.

Additional Knowledge:
Gagan-Sakhi (Option A)

"Gagan-Sakhi" translates to "Space Female Friend", but it is not the official name given by ISRO for their humanoid robot.

Nabha-Nari (Option B)

"Nabha-Nari" translates to "Sky Woman", which is a descriptive term but not the official project name given by ISRO.

Mitra (Option D)

While "Mitra" means friend and is part of the robot's official name, the full and correct name is Vyommitra, to specifically denote its role as a
space friend.

Q.11   In which session of the INC did the split into Extremists and Moderates take place?

A. Nagpur Session, 1891
B. Lucknow Session, 1916
C. Surat Session, 1907
D. Calcutta Session, 1896

Answer: C

https://www.adda247.com/
https://applink.adda247.com/d/XhqWf9lSap


Sol: The correct answer is (c) Surat Session, 1907.
• The Indian National Congress split into Moderates & Extremists in 1907 at the Surat Session.
• Extremists wanted aggressive methods; Moderates believed in constitutional reforms.
• Major leaders involved: Bal Gangadhar Tilak (Extremist) & Gopal Krishna Gokhale (Moderate).
• This split weakened the freedom struggle temporarily.
Information Booster:
• INC founded in 1885 by A.O. Hume.
• First Session – 1885, Bombay – Presided by W.C. Bonnerjee.
• Key Moderate Leaders – Dadabhai Naoroji, G.K. Gokhale, Pherozeshah Mehta.
• Key Extremist Leaders – B.G. Tilak, Lala Lajpat Rai, Bipin Chandra Pal.
• Split aimed to expel the aggressive methods of Tilak group.
Additional Knowledge:
• Lucknow Session 1916 – Reunion of Moderates & Extremists + Lucknow Pact with Muslim League.
• Calcutta Session 1896 – Vande Mataram was sung for 1st time.
• Nagpur Session 1891 – No major split occurred.
• Extremists gained popularity after Partition of Bengal (1905).

Q.12   Who among the following was the President of the Muslim League in 1930?

A. Muhammad Ali Jinnah
B. Jawahar Lal Nehru
C. Sir Mohammad Iqbal
D. Maulana Azad

Answer: C

Sol: The correct answer is: (C) Sir Mohammad Iqbal
Explanation:
● In 1930, Sir Mohammad Iqbal (Allama Iqbal) became the President of the Muslim League.
● He is famous for his Allahabad Address (1930) where he first proposed the idea of a separate Muslim state, which later became Pakistan.
● His presidency played a key role in shaping Muslim political thought in British India.
● Muhammad Ali Jinnah rejoined the League later, but he was not president in 1930.
● Jawaharlal Nehru and Maulana Azad were Congress leaders, not part of the Muslim League.
Additional Knowledge:
● Sir Mohammad Iqbal is also known as the ‘Spiritual Father of Pakistan’.
● He was a poet, philosopher, and politician associated with Muslim nationalism.
● His famous poem “Sare Jahan Se Achha” is widely known in India.
● He presided over the Allahabad Session of 1930 Muslim League.
● He died in 1938, before the creation of Pakistan.

Q.13   ‘Pradhan Mantri Fasal Bima Yojana’ was introduced in the year –

A. 2014
B. 2015
C. 2016
D. 2017

Answer: C

Sol: The correct answer is (c) 2016
Explanation:
· The 'Pradhan Mantri Fasal Bima Yojana' (PMFBY), a flagship crop insurance scheme by the Government of India, was introduced in the year
2016.
· The scheme was launched on February 18, 2016, by Prime Minister Narendra Modi.
· It replaced the earlier existing schemes, the National Agricultural Insurance Scheme (NAIS) and Modified NAIS (MNAIS), aiming to provide
comprehensive insurance coverage against crop losses due to natural calamities.
Information Booster:
· The scheme aims to provide financial support to farmers suffering crop loss/damage arising out of unforeseen events.
· It provides a uniform premium of only 2% for all Kharif crops, 1.5% for all Rabi crops, and 5% for annual commercial and horticultural crops.
· The scheme is implemented by empanelled general insurance companies under the guidance of the Ministry of Agriculture & Farmers Welfare.
Additional Knowledge: (a) 2014 (Option a) . The year 2014 saw the launch of other key government schemes, such as the Pradhan Mantri Jan
Dhan Yojana (PMJDY) and Swachh Bharat Abhiyan.
(b) 2015 (Option b) . The year 2015 saw the launch of schemes like the Pradhan Mantri Mudra Yojana (PMMY) and Atal Pension Yojana
(APY).
(d) 2017 (Option d) . The year 2017 saw the nationwide implementation of the Goods and Services Tax (GST) and the launch of the Pradhan
Mantri Vaya Vandana Yojana (PMVVY).
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Q.14   Agro-forestry was conceived on the recommendation of which policy to promote plantation on farmlands?

A. Protection of Plant Varieties & Farmers' Rights Act, 2001
B. National Agro-forestry Policy, 2019
C. National Forest Policy of 2018
D. National Agro-forestry Policy, 2014

Answer: D

Sol: The correct answer is: D – National Agro-forestry Policy, 2014

Explanation (in bullet points):

• Agro-forestry promotion on farmlands was formally conceived under the National Agro-forestry Policy, 2014.
• This was India’s first-ever agro-forestry policy, aimed at integrating trees with crops and livestock systems.
• The policy encourages farmers to plant trees by simplifying regulations and promoting market access for timber and tree products.

Information Booster :

• India became the first country in the world to adopt a dedicated agro-forestry policy in 2014.
• The policy supports carbon sequestration, soil fertility improvement, and climate resilience.
• It promotes National Agro-Forestry Mission (Sub-Mission on Agro-Forestry – SMAF) under NMSA.
• Encourages private sector investment in nurseries, processing, and value chains.
• Helps reduce pressure on natural forests by increasing tree cover on farmlands.

Additional Knowledge:

• PPV&FR Act, 2001 deals with plant breeders’ rights, not agro-forestry.
• National Forest Policy 2018 (draft) focuses on forest conservation, not farm-based plantations.
• National Agro-forestry Policy 2019 does not exist; only 2014 is officially recognized.
• Agro-forestry enhances farm income, provides fuelwood, fodder, timber, and improves soil moisture.
• It also contributes to India’s target of 33% forest and tree cover.

Q.15   Which technology uses acoustic waves to locate objects in the ocean?

A. Sonar
B. LiDAR
C. Echo-sounder
D. SAR

Answer: A

Sol: The correct answer is (a) Sonar

Explanation:

• Sonar (Sound Navigation and Ranging) is a technology that uses acoustic (sound) waves to detect and locate objects
under the sea.

• It works by emitting sound pulses into the water, which reflect off objects and return as echoes.

• By measuring the time delay and strength of the echo, the distance and position of underwater objects can be
determined.

• Sonar is widely used in submarine navigation, underwater exploration, mapping the ocean floor, and detecting
obstacles or marine life.

Information Booster:

• There are two main types of sonar:

https://www.adda247.com/
https://applink.adda247.com/d/XhqWf9lSap


– Active Sonar: Sends out sound waves and listens for echoes.

– Passive Sonar: Merely listens for sounds made by other objects (e.g., submarines or marine animals).

Additional Knowledge:

(b) LiDAR

• Light Detection and Ranging uses laser pulses to measure distances.

• Effective on land but not suitable underwater due to light scattering in water.

(c) Echo-sounder

• A specific application of sonar used to measure sea depth.

• It’s not the general name for the technology.

(d) SAR (Synthetic Aperture Radar)

• Uses microwave signals to create high-resolution images from space or aircraft.

• Not effective for underwater object detection.

Q.16   What is the full form of OTP?

A. One Time Process
B. One Time Password
C. Online Transfer Protocol
D. Open Transaction Path

Answer: B

Sol: The correct answer is (b) One Time Password.
Explanation:

Point 1: OTP stands for One Time Password, which is a unique numeric or alphanumeric code used only once for security verification.

Point 2: It is commonly sent via SMS, email, or authenticator apps to confirm identity during online transactions or logins.

Point 3: OTP enhances security by preventing unauthorized access even if someone knows the primary password.

Information Booster:

OTPs are used in Two-Factor Authentication (2FA).

They usually expire within 30–60 seconds.

Popular platforms like banks, UPI apps, Gmail, etc., use OTP for secure access.

OTP codes are typically 4–8 digits long.

Additional Knowledge:

(a) One Time Process

Incorrect; does not relate to cybersecurity or authentication.

(b) One Time Password
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Correct; used for user identity verification.

(c) Online Transfer Protocol

Incorrect; no such protocol exists in networking terminology.

(d) Open Transaction Path

Incorrect; not a recognized technical term.

Q.17   What is the Shanti Swarup Bhatnagar Prize given in recognition of?

A. Spiritual leadership
B. Military courage
C. Scientific research
D. Contemporary painting

Answer: C

Sol: The correct answer is (c) Scientific research

Explanation:
• The Shanti Swarup Bhatnagar Prize for Science and Technology is a prestigious national award in India given for outstanding
contributions to scientific research.
• It is named after Dr. Shanti Swarup Bhatnagar, the founder Director-General of the Council of Scientific and Industrial Research (CSIR), which
institutes the award.
• The prize recognizes both applied and fundamental research in seven different scientific disciplines, including biological, chemical, and medical
sciences.

Information Booster:
• The award was first instituted in 1958.
• It is awarded annually to Indian citizens, Overseas Citizens of India (OCI), and Persons of Indian Origin (PIO) working in India who are below the
age of 45.
• The award includes a cash prize of ₹5,00,000, a citation, and a plaque.

Additional Knowledge:
Spiritual leadership (Option a)
• Awards for spiritual leadership, such as the Templeton Prize, are different and focus on contributions to religious or spiritual life.

Military courage (Option b)
• Military courage and gallantry are recognized through awards like the Param Vir Chakra, Maha Vir Chakra, and Vir Chakra in India.

Contemporary painting (Option d)
• Awards for painting and other forms of art are typically given by cultural academies or institutions, such as the Lalit Kala Akademi in India.

Q.18   What should come in place of the question mark (?) in the given series?
150, 139, 128, 117, 106, ?

A. 101
B. 87
C. 82
D. 95

Answer: D

Sol: Given:
150, 139, 128, 117, 106, ?
Logic: Each term is obtained by subtracting 11 from the previous term.
150 − 11 = 139
139 − 11 = 128
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128 − 11 = 117
117 − 11 = 106
106 − 11 = 95
So, ? = 95
Thus, the correct option is (D) 95.

Q.19   Which of the following terms will replace the question mark (?) in the given series?
DGA, FKE, ?, JSO, LWU

A. HOI
B. HOT
C. HTI
D. HII

Answer: A

Sol: Given:
​DGA, FKE, ?, JSO, LWU

Logic: ​First letter increases by +2, second letter by +4, and third letter by +4 in alphabetically.
​First letter: D + 2 → F, F + 2 → H, H + 2 → J, J + 2 → L
Second letter: G + 4 → K, K + 4 → O, O + 4 → S, S + 4 → W
Third letter: A + 4 → E, E + 4 → I, I + 4 → M, M + 4 → Q
So, the missing term is HOI.
Thus, the correct option is: (a)

Q.20
 

Select the option that is related to the fifth letter-cluster in the same way as the second letter-cluster is related to the first letter-cluster and the
fourth letter-cluster is related to the third letter-cluster.
SERIOUS : FTJSVPT :: UNKNOWN : OVOLXPO :: WARNING : ?

A. BXOSOJH
B. XBSOJOH
C. BXSOJOH
D. BXSOOJH

Answer: A

Sol: Given:
​SERIOUS : FTJSVPT :: UNKNOWN : OVOLXPO :: WARNING : ?

Let's check:
​SERIOUS : FTJSVPT

UNKNOWN : OVOLXPO
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Similarly,
WARNING : ?

So, WARNING : BXOSOJH
Thus, the correct option is: (a)

Q.21   Which option figure will replace the question mark (?)

A. 

B. 

C. 

D. 

Answer: C

Sol: Logic: The central square is rotating at 45° in every successive step.
The position of other shapes is moving and rotating clockwise 90° at each step and every shape in upper left and lower right quadrant is always solid.

Thus, correct option is (c).

Q.22   Which option figure will replace the question mark (?) to complete the given pattern?

A. 
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B. 

C. 

D. 

Answer: B

Sol: The missing figure that will complete the figure is shown below.

Thus, the correct option is (b).

Q.23
 

Town J is to the west of town M. Town N is to the south of Town M. Town K is to the west of Town N. Town L is to the south of town N. What is the
position of town L with respect to town K?

A. Northeast
B. Southwest
C. Northwest
D. Southeast

Answer: D

Sol: Given:
Town J is to the west of town M.
Town N is to the south of town M.
Town K is to the west of town N.
Town L is to the south of town N.
According to the given information, positional diagram will be:

So L is Southeast of K.
Thus, the correct option is (D) Southeast

Q.24
 

Based on the English alphabetical order, three of the following four letter-cluster pairs are alike in a certain way and thus form a group. Which
letter-cluster pair DOES NOT belong to that group?
(Note: The odd one out is not based on the number of consonants/ vowels or their position in the letter-cluster.)

A. LP-GJ
B. RV-MP
C. OS-JN
D. IM-DG

Answer: C
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Sol: Given:
Letter-cluster pairs: LP–GJ, RV–MP, OS–JN, IM–DG
Logic: 1st letter − 5 = 3rd letter, 2nd letter − 6 = 4th letter

Option (A): LP – GJ → Follows the logic
L − 5 = G
P − 6 = J
Option (B): RV – MP → Follows the logic
R − 5 = M
V − 6 = P
Option (C): OS – JN → Does not follow the logic
O − 5 = J
S − 6 = M (≠ N)
Option (D): IM – DG → Follows the logic
I − 5 = D
M − 6 = G
Thus, the correct option is (C) OS – JN.

Q.25   Three of the following four words are alike in a certain way and one is different. Select the odd one.

A. Disseminate
B. Congregate
C. Disperse
D. Scatter

Answer: B

Sol: Given:
Four words: Disseminate, Congregate, Disperse, Scatter
Explanation:
Disseminate → to spread
Disperse → to scatter
Scatter → to spread in different directions
Congregate → to gather (opposite meaning)
Hence, Congregate is the odd one.
Thus, correct option is (b).

Q.26
 

Based on the English alphabetical order, three of the following four letter-cluster pairs are alike in a certain way and thus form a group. Which
letter-cluster pair DOES NOT belong to that group?
(Note: The odd one out is not based on the number of consonants/vowels or their position in the letter-cluster.)

A. LT-PQ
B. MU-RQ
C. PX-UT
D. EM-JI

Answer: A

Sol:

a. LT - PQ → L +4 = P, T - 3 = Q
b. MU - RQ → M +5 = R, U -4 = Q
c. PX - UT → P +5 = U, X -4 = T
d. EM - JI → E +5 = J, M -4 = I
Options B, C, and D follow the same pattern: first letter +5, second letter -4
Only Option A has a different pattern: +4 and -3.
Thus, correct option is (a).
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Q.27   Study the given table and answer the question that follows.
The given table depicts the percentage of marks scored by Mary and Perul in History
and Physics (out of 75 each).

NameHistoryPhysics

Mary 60 64

Parul 54 70

How many marks did Mary score in History?

A. 45
B. 53
C. 37
D. 47

Answer: A

Sol: Given: ​
Maximum marks in History = 75

Percentage marks scored by Mary in History = 60%

Solution: ​

Marks obtained = ​​​ ×
100
60

75 = 45

Q.28
 

The following pie diagram shows information on tyre manufacturing by various companies in India during 2017. If the total number of tires
produced in India during 2017 was 1,80,000 units, how many units of tyres were produced by company E?

A. 30,000
B. 35,000
C. 45,000
D. 15,000

Answer: C

Sol: Solution:
Total number of tyres produced in 2017 by various companies = 180,000

Tyres produced by company E is 25% of 180000 = ​× 180,000 = 45,000​

100
25
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∴ The number of tyres produced by company E in 2017 is 45,000

Q.29
 

The following line graph shows the ratio of the quantity of imports by a company to the quantity of exports from that company during the period
2005 to 2011.
Ratio of value of imports and exports by a company over the past few years

If the imports of the company in 2006 were ₹ 400 crores, then what were the exports of the company in 2006 (in ₹ crores)?

A. Rs 260 crores
B. Rs 320 crore
C. Rs 350 crore
D. Rs 200 crore

Answer: B

Sol: Given: ​
Ratio of import to export in 2006 = 1.25

Import of the company in 2006 = Rs. 400 cr.

Solution:

Import to export = 1.25 = 

Export of the company in 2006 = ​​

​ =
100
125

​

4
5

400 × ​ =
5
4

Rs. 320 cr

Q.30
 

The income of x is 80% more than that of y, and the income of z is 60% of the total income of x and y. The income of z is what percentage less than
that of x (correct to one decimal place)?

A. 6.3%
B. 7.1%
C. 7.3%
D. 6.7%

Answer: D

Sol: Given:
Income of x is 80% more than y.
Income of z is 60% of total income of x and y.
Find how much percent less z's income is than x's .

Formula Used:

If x = a and y = b, percent less ​​

Solution:
Let y = Y Then x = 1.8Y
Total x + y = 1.8Y + Y = 2.8Y
So z = ​​

= ​ ×
x

x − z
100

0.6 × 2.8Y = 1.68Y
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Difference x - z = 1.8Y - 1.68Y = 0.12Y

Percent less = ​​

Rounded to one decimal place = 6.7% less.

​ ×
1.8Y
0.12Y

100 = ​ ×
1.8
0.12

100 = ​ ×
15
1

100 = 6.666 … %

Q.31
 

Sabita decides to donate 8% of her monthly income to a charitable trust. On the day of donation, she changes her decision and donates ₹2,880,
which is 20% less than the amount she had originally decided to donate. What is her monthly income (in ₹)?

A. Rs. 36,000
B. Rs. 48,000
C. Rs. 45,000
D. Rs. 40,000

Answer: C

Sol: Given:
Decided donation = 8% of income
Actual donation = ₹2880
Actual donation is 20% less than decided donation.

Solution:

​ ​

Now,

Decided donation = 0.08  Income

Now,

​​

Actual = 0.8 × Decided

0.8 × Decided = 2880

Decided = ​ =
0.8

2880
3600

×

0.08 × Income = 3600

Income = ​ =
0.08
3600

45, 000

Q.32
 

A sum of Rs. x is divided between A, B and C such that the ratio of the shares of A and B is 3: 5, and that of B and C is 4: 7. If the difference
between the shares of A and C is Rs. 2,001, then the value of x is:

A. 5,481
B. 5,742
C. 5,655
D. 5,829

Answer: D

Sol: Given:
A : B = 3 : 5
B : C = 4 : 7
Difference between A and C = 2001

Solution:

Equalize B in both ratios
A : B = 3 : 5
B : C = 4 : 7
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LCM of 5 and 4 = 20

Convert ratios:
A : B = 3 : 5 → multiply by 4 → 12 : 20
B : C = 4 : 7 → multiply by 5 → 20 : 35

Combined ratio:
A : B : C = 12 : 20 : 35

Difference between shares
C − A = 35 − 12 = 23 parts = 2001

1 part ​​

Total sum
A + B + C = 12 + 20 + 35 = 67 parts

Value of x = 6 ​87 = 5829

= ​ =
23

2001
87

7×

Q.33
 

The average weight of a certain number of persons in a group is 78 kg. If 4 persons having average weight 80.75 kg leave the group, the average
weight of the remaining persons becomes 77.725 kg. The number of persons, initially, is:

A. 36
B. 44
C. 46
D. 34

Answer: B

Sol: Given:
Initial average weight = 78 kg
4 persons leave whose average = 80.75 kg
New average = 77.725 kg
Formula Used:

​​

Solution:

Let initial number of persons = n
Total weight initially = 78n
Weight lost = 4 ​​

Remaining persons = n - 4
Total weight of remaining = 78n - 323

​

Average = ​

Number of observations
Sum of all observations

×80.75

New average = ​

n − 4
78n − 323

​ =
n − 4

78n − 323
77.725

78n − 323 = 77.725n − 310.9

78n − 77.725n = 323 − 310.9

0.275n = 12.1

n = ​ =
0.275
12.1

44
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Q.34
 

A certain sum amounts to Rs. 5,808 after 2 years and to Rs. 7,320 after 5 years at the same rate per cent per annum at simple interest. What will be

the simple interest on a sum of Rs. 8,500 for ​ years at the same rate?

A. Rs. 4,352
B. Rs. 4,165
C. Rs. 4,440
D. Rs. 4,760

Answer: B

Sol: Given:
Amount after 2 years = ₹5808
Amount after 5 years = ₹7320
Difference in time = 3 years

Find SI on ₹8500 for ​ years

​ ​​

Formula Used:

Rate:

SI =

where , SI = Simple interest ,

P = Principal , R = rate , T= time

Solution:

Simple Interest difference:
​ ​​

​ ​​

​ ​

Amount after 2 years = 5808
SI for 2 years = ​​

P = 5808 - 1008 = 4800

​ ​​

504 = ​​

504 = 48R
R = 10.5%

Find SI for ₹8500 for ​ years

SI = ​​

=  = 4165​

4 ​

3
2

4 ​

3
2

4 ​ =
3
2

​ years
3

14

​

100
P × R × T

SI ​ =3 yrs A ​ −5 A ​2

SI ​ =3 yrs 7320 − 5808 = 1512

SI ​ =1 yr ​ =
3

1512
504

504 × 2 = 1008

SI = ​

100
P × R × T

​

100
4800 × R × 1

​

3
14

​

100
8500 × 10.5 × ​3

14

​

300
8500 × 10.5 × 14

Q.35
 

A sum of ₹8,000 amounts to ₹13,824 in 3 years at R% p.a., interest compounded annually. What will it amount to in 1 ​ years at the same rate, if the

interest is compounded half-yearly?

A. 10648
B. 10148

​

4
1
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C. 10164
D. 10872

Answer: C

Sol: Given:
The principal is Rs. 8,000

The amount after 3 years compounded annually at R% p.a. is Rs. 13,824

Formula used:
Amount = Principal (1 + Rate/100)ᵗⁱᵐᵉ

Solution:

The principal is Rs. 8,000

The amount after 3 years compounded annually at R% p.a. is Rs. 13,824

Amount = Principal (1 + Rate/100)ᵗⁱᵐᵉ

13824 = 8000 (1 + R/100)³

​ ​= 1 + (R/100)

24/20 = 1 + R/100

24/20 - 1 = R/100

R = 4/2 ​​

R = 20%

The compound interest when rate is compounded half-yearly for 1 ​ years

First, Amount for 1 year

Time = ​ = 2 years

Rate = 20/2 = 10%

Amount = Principal (1 + Rate/100)ᵗⁱᵐᵉ

Amount = ​​

Amount = 8000 × (11/10) × (11/10)

Amount = 9680

Now, Simple Interest for 1/4 year

Time = 6 Months = 1 Year

1/4 Year = 3 Months = 1/2 Year (Compounded half yearly)

Rate = 20/2 = 10%

Simple interest = (Principal × Rate × Time)/100

Simple interest = ​​

Simple interest = 484

​

3
​

8000
13824

0 × 100

​

4
1

2 × 1

8000(1 + 10/100)2

​

100
(9680 × ​ × 10)2

1
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Total amount = 9680 + 484

Total amount = 10164

Q.36
 

A dealer buys two articles X and Y for ₹2,000 each. He marks each of them at the same price. He sells X by giving two successive discounts of 44%
and 37% and still earns ₹989 as profit. If he sells Y at a single discount of 64%, then what is the profit percentage on Y?

A. 52%
B. 51.5%
C. 51%
D. 52.5%

Answer: D

Sol: Given:
Cost Price of X and Y = ₹2000 each

Marked Price of X = Marked Price of Y = (M)

Successive discounts on X = 44% and 37%

Profit on X = ₹989

Single discount on Y = 64%

Required: Profit percentage on Y

Formula Used:

SP = CP + Profit

SP = MP ​​

Profit % = ​​

Solution:

Selling price of X = 2000 + 989 = 2989

SP(X) = MP 

2989 = MP × 

MP =  = 8,472.22​

Selling price of Y with 64% discount:

SP(Y) = ​

​

​​

Profit on Y = 3050 - 2000 = 1050

× 1 − ​ ×(
100
D ​1 ) 1 − ​(

100
D ​2 )

​ ×
CP

P
100

× 1 − ​ ×(
100
44 ) 1 − ​(

100
37 )

​ ×
100
56

​

100
63

​

56 × 63
2989 × 100 × 100

​ ×
56 × 63

2989 × 100 × 100
​(

100
36 )

= 2989 × ​

3528
3600

= 2989 × ​

98
100

= 3050

1050
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Profit % = ​ = 52.5%​ ×
2000
1050

100

Q.37
 

Ritu, Sameer, and Isha invest ₹1,350, ₹1,470, and ₹1,380, respectively, to start a business. If the profit at the end of the year is ₹1,330, then what is
the share of Isha in the profit?

A. ₹439
B. ₹437
C. ₹435
D. ₹438

Answer: B

Sol: Given:
Investment of Ritu = ₹1350

Investment of Sameer = ₹1470

Investment of Isha = ₹1380

Total profit = ₹1330

Find Isha’s share in profit.

Concept Used:

Profit divided in the ratio of investments.

Solution:

Total Investment = 1350 + 1470 + 1380 = 4200

Isha's Share = ​​

= ​​

= ₹437

​ ×
4200
1380

1330

​ ×
70
23

1330

Q.38
 

Train A travelling at 55 km/h takes 21 seconds to cross completely train B travelling at 53 km/h in the opposite direction. The length of train A is 2.5
times the length of train B. Train A passes a bridge in 72 seconds. What is the length (in m) of the bridge?

A. 650
B. 600
C. 550
D. 575

Answer: A

Sol: Given:
Speed of A = 55 km/h, Speed of B = 53 km/h (opposite directions).
Time to cross each other = 21 s.
Length of A = 2.5 × length of B.
A passes a bridge in 72 s. Find length of bridge.

Formula Used:
Distance covered while crossing = relative speed × time
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Solution:

Relative speed = ​ m/s.

So ​ m.
With ​

​​

​ ​180 m, ​450 m.

Speed of A = ​ m/s.

Distance in 72 s ​ m.

Bridge length = 1100 - 450 = 650 m

(55 + 53) × ​ =
18
5

108 × ​ =
18
5

30

L ​ +A L ​ =B 30 × 21 = 630
L ​ =A 2.5L ​ :B

2.5L ​ +B L ​ =B 3.5L ​ =B 630

L ​ =B L ​ =A

55 × ​ =
18
5

​

18
275

= ​ ×
18

275
72 = 275 × 4 = 1100

Q.39   Address 1: Mrs. Priya Desai, 503/3, Orchid Boulevard, Hyderabad - 500090
Address 2: Mrs. Priya Desai, 503/3, Orchid Boulevard, Hyderabad - 500091

Are these likely to be the same?

A. No, city codes do not match
B. Yes, all major details match
C. No, the flat numbers are different
D. No, the postal codes are different

Answer: D

Sol: The house number, road name, and city name are the same, with only the postal code differing slightly ("500090" vs "500091").

Conclusion: The addresses are very similar and likely the same with a minor postal code difference.

Correct Answer:
D) No, the postal codes are different

Q.40   Address 1: Ms. Rina Dey, Flat No. 302, Block A, Sunrise Apartments, Mumbai -400089
Address 2: Ms. Rina Dey, A-302, Sunrise Apt. Mumbai 400089
Which of the following is TRUE? ​​

A. The addresses refer to the same location
B. The city pin codes are different
C. The apartment names differ
D. The block and flat number do not match

Answer: A

Sol: Given:
Address 1: Ms. Rina Dey, Flat No. 302, Block A, Sunrise Apartments, Mumbai -400089
Address 2: Ms. Rina Dey, A-302, Sunrise Apt. Mumbai 400089
Let’s compare carefully:
Flat No. 302, Block A = A-302 → same.
Sunrise Apartments = Sunrise Apt. → same.
Mumbai - 400089 = Mumbai 400089 → same PIN.
Both addresses point to the same location.
So, The addresses refer to the same location.
Thus, correct option is (a).

Q.41   Which of the following is an incorrect pair of abbreviation and its full form?

A. DBMS-Data Base Management System
B. URL-Uniform Reserve Locator
C. RAM- Random Access Memory
D. FAX-Facsimile
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Answer: B

Sol: Correct Answer: (b) URL – Uniform Reserve Locator
Explanation:

The abbreviation "URL" actually stands for Uniform Resource Locator, not "Uniform Reserve Locator".

A URL is the address of a web page on the internet used to access websites and resources online.

Information Booster:
Correct Full Forms:

1. DBMS – Database Management System: Software that manages and organizes databases.

2. RAM – Random Access Memory: A type of volatile memory used by computers for temporary storage.

3. FAX – Facsimile: A method of sending scanned printed material (text or images) over a telephone line.

Q.42   ______________ is the primary component of a CPU that performs all arithmetic and logical operations during data processing.

A. Cache Unit
B. Auxiliary Memory
C. Arithmetic and Logic Unit (ALU)
D. Registers

Answer: C

Sol: The Arithmetic and Logic Unit (ALU) is a core component of the CPU responsible for performing arithmetic calculations (such as addition and
subtraction) and logical operations (such as comparisons). It processes the data fed to it by the CPU's Control Unit.
Important Key Points:
1. The ALU handles all mathematical and logical tasks required for the execution of instructions.
2. It works in conjunction with the Control Unit and Registers to perform the CPU’s tasks.
Knowledge Booster:
· Cache Unit helps in speeding up the data retrieval process and improves overall system performance.
· Registers are high-speed memory locations in the CPU that store temporary data during processing.
· Auxiliary Memory (like hard drives) is used for long-term storage, not for high-speed CPU tasks.

Q.43   Which one of the following is not an audio file format?

A. MIDI
B. WAV
C. SWF
D. MPEG

Answer: C

Sol: SWF is a web-based multimedia format designed for vector graphics and interactive animations, not exclusively for storing or playing audio.
It can embed sound but is not used as a standalone audio format.
Important Key Points:
1. SWF is associated with Flash content and browser-based animations.
2. Dedicated audio formats are intended for encoding and decoding sound data only.
Knowledge Booster:
· MIDI: Stores musical note data, often used in synthesizers.
· WAV: Contains high-quality audio, typically uncompressed.
· MPEG: A compression standard that includes audio layers like MP3.

Q.44   Which of the following function keys is used to enter full-screen mode in Google search engine?

A. F10
B. F11
C. F5
D. F2
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Answer: B

Sol: The keyboard shortcut F11 is used to enter full-screen mode in most web browsers, including while using Google Search. When you press F11, the
browser interface (toolbars, tabs, and address bar) is hidden, allowing for an immersive, full-screen viewing experience. This mode is especially useful
for maximizing screen space when viewing content like videos, presentations, or websites.
Important Key Points:
1. F11 Function: F11 is the standard key to toggle between full-screen and normal mode in most web browsers. It helps users remove distractions by
hiding the browser's interface, leaving only the webpage content visible.
2. Browser Compatibility: This key is supported across all major browsers such as Google Chrome, Firefox, Edge, and Safari, making it a universal
shortcut for full-screen viewing.
Knowledge Booster:
· F10: This function key is often used to activate the menu bar in applications or web browsers.
· F5: The F5 key is widely used to refresh or reload the current web page, ensuring that the latest content is displayed.
· F2: This key is typically used to rename selected files or folders in most operating systems, not for browser-related functions.

Q.45   Which of the following shortcut key used to open new incognito window in Google Chrome?

A. Ctrl + N
B. Ctrl + Shift + N
C. Ctrl + Shift + W
D. Ctrl + Shift + Tab

Answer: B

Sol: The shortcut Ctrl + Shift + N opens a new incognito window in Google Chrome. In incognito mode, the browser does not save browsing history,
cookies, or form data, providing a private browsing experience.
Important Key Points:
1. Incognito mode is useful for private browsing but does not make the user anonymous to websites or internet service providers.
2. The same shortcut works in browsers like Microsoft Edge.
3. Extensions may still track activity unless disabled explicitly for incognito mode.
Knowledge Booster:
· Ctrl + N: Opens a regular new browser window.
· Ctrl + Shift + W: Closes all tabs in the current window.
· Ctrl + Shift + Tab: Moves to the previous browser tab.

Q.46   Which of the following is an incorrect way to add values stored in cells C1, C2, C3, C4, and C5 of an Excel sheet?

A. = C1 + C2 + C3 + C4 + C5
B. = SUM(C1, C2, C3, C4, C5)
C. = ADD(C1, C2, C3, C4, C5)
D. = SUM(C1 : C5)

Answer: C

Sol: The ADD function is incorrect in Excel. There is no ADD function in Excel. The correct function for adding values in Excel is SUM. Options (a), (b), and
(d) are correct ways to add values in Excel.
Important Key Points:
1. = C1 + C2 + C3 + C4 + C5: This is a direct formula for adding the values in cells C1, C2, C3, C4, and C5.
2. = SUM(C1, C2, C3, C4, C5): The SUM function is the correct and preferred way to add values in Excel.
3. = SUM(C1 : C5): This is a shorthand for adding the values in the range C1 to C5. It’s a valid and efficient method.
Knowledge Booster:
· = ADD(C1, C2, C3, C4, C5): There is no ADD function in Excel. The correct function for summing values is SUM.

Q.47   Which sequence of steps correctly initiates a blank presentation in MS PowerPoint 2016 or later?

A. File → New → Blank Presentation
B. File → Save As → Blank Template
C. View → New Window → Blank
D. Home → Layout → Clear All

Answer: A
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Sol: Sol.

Correct Ans is (A) File → New → Blank Presentation

Explanation:

To start a blank presentation in MS PowerPoint 2016 or later, follow these steps:

File → New → Blank Presentation.

This sequence will create a new, empty presentation in PowerPoint.

Additional Information:

(B) File → Save As → Blank Template: This option is used for saving the presentation as a template, not for starting a new one.
(C) View → New Window → Blank: This opens a new window, not a new blank presentation.
(D) Home → Layout → Clear All: This is used to clear the layout of the current slide, not for creating a new presentation.

Q.48   Which of the following keys is used to create a new paragraph in MS-Word?

A. Esc
B. Enter
C. Spacebar
D. Ctrl

Answer: B

Sol: Correct Answer: B) Enter
Explanation:

In MS-Word, the Enter key is used to create a new paragraph.
Pressing Enter moves the cursor to the next line and starts a new paragraph, maintaining the formatting of the previous paragraph.

Information Booster:

The Esc key is used to cancel ongoing actions or exit menus.
The Spacebar is used to insert spaces between words or characters.
The Ctrl key is used in combination with other keys for shortcuts (e.g., Ctrl+C for copy, Ctrl+V for paste).
Proper use of the Enter key helps in organizing text into readable paragraphs, enhancing document formatting and presentation.

Q.49   ​Which of the following is not a type of primary memory?​

A. Random Access Memory (RAM)​
B. Read Only Memory (ROM)​
C. Cache Memory​
D. Magnetic Disk​

Answer: D

Sol: The correct answer is:(d) Magnetic Disk
Explanation:

Primary memory refers to the main memory that is directly accessible by the CPU. It is used to store data that is currently being processed
or is essential for immediate tasks.

RAM (Random Access Memory) is the most common type of primary memory, providing fast, temporary storage that is erased
when the computer is turned off.

ROM (Read Only Memory) is a type of non-volatile primary memory that stores essential boot-up instructions and is not typically
altered.

Cache memory is a high-speed temporary storage located between the CPU and RAM to speed up data retrieval and processing.
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Magnetic Disk, on the other hand, is a type of secondary memory, which is used for long-term data storage. Examples include hard drives
(HDDs) and floppy disks. Unlike primary memory, secondary memory is not directly accessed by the CPU and is used to store data
persistently.

Information Booster:
• Primary memory is volatile, meaning it loses its contents when the power is turned off.

• Cache memory is the fastest type of memory and is used to store frequently accessed data to reduce CPU delays.

• RAM is essential for running applications and processing tasks.

• ROM is non-volatile and is used to store the firmware or essential boot instructions.

• Magnetic disks are used for permanent storage and are slower than primary memory.

Q.50   Which of the following is the world’s first graphical Internet browser?

A. Internet Explorer
B. Erwise
C. Chrome
D. Safari

Answer: B

Sol: The correct answer is (b)Erwise.
Explanation:
· Erwise was an early web browser and the first that was available for the X Window System, offering a graphical user interface (GUI).
· It was developed as a student project at the Helsinki University of Technology (now Aalto University) in Finland.
· Erwise was released in April 1992, making it the first widely available browser with a graphical interface.
· It featured multiple windows, clickable links displayed graphically, and the ability to view images inline with text, which significantly enhanced the
user experience.
· The development of Erwise ceased in 1994 after the students graduated.
Information Booster:
· While WorldWideWeb (later renamed Nexus) was the first web browser created by Tim Berners-Lee in 1990, it initially had a text-based interface and
displayed images in separate windows.
· Mosaic, released in 1993, is often credited as the first popular graphical web browser and was significant for displaying images inline with text.
Additional Knowledge: Internet Explorer (Option a)
· Internet Explorer is a series of graphical web browsers developed by Microsoft and first released in 1995.
· It was initially included as part of the Plus! add-on package for Windows 95.
Chrome (Option c)
· Google Chrome is a cross-platform web browser developed by Google and first released in 2008.
· It is based on the open-source Chromium project and initially used the WebKit rendering engine, later forking it to create the Blink engine.
Safari (Option d)
· Safari is a graphical web browser developed by Apple, based on the WebKit engine.
· It was first released for Mac OS X in 2003 and later for Windows and iOS devices.
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